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Trademarks 
© 2011 Founer Inc. All rights are reserved. No portion of this document may be 
reproduced without permission. All trademarks and brand names mentioned in this 
publication are property of their respective owners. 
 

Liability 
While all efforts have been made to ensure the accuracy of all contents in this manual, 
we assume no liability for errors or omissions or by statements of any kind in this manual, 
whether such errors are omissions or statements resulting from negligence, accidents, or 
any other cause. The contents of this manual are subject to change without notice. We 
will not shoulder any legal liability, if users failed to follow the operation instructions in this 
manual. 
 

Copyright 
The scanning of certain documents, for example checks, bank notes, I.D. cards, 
government bonds, or public documents, may be prohibited by law and/or subject to 
criminal prosecution. We recommend you to be responsible and respectful of the 
copyrights laws when you are scanning books, magazines, journals and other materials. 
 

Environmental Information 
Recycle or disposal at end-of-life information, please ask local distributors or suppliers for 
recycle and disposal information. The product is designed and produced to achieve 
sustainable environmental improvement. We strive to produce products in compliance 
with global environmental standards. Please consult your local authorities for proper 
disposal. 
 
The product packaging is recyclable. 
 
Attention for recycling (For EU country only) 
Protect your environment! This product should not be thrown into the household waste 
container. Please give it to the free collecting center in your community. 
 

Screen Examples in This Manual 
The screen shots in this guide were made with Windows XP.  If you are using Windows 
2000/ Vista/ 7, your screen will look somewhat different but functions the same. 
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Introduction 
Welcome to the world of Founder scanners – the ultimate in computer imaging. 

Your new scanner will improve the professionalism of your day-to-day computing tasks 
by allowing you to input images and electronic text into your computer system. 

Like all of our products, your new scanner is thoroughly tested and backed by our 
reputation for unsurpassed dependability and customer satisfaction. 

Please remember to register your scanner by registering online via Founder’s 
website. 

See the last page of this user’s guide for a complete list of Founder offices 
worldwide. 

As a registered customer, you will receive customer support, new product 
information and software upgrades. 

Thank you for choosing us as your scanner supplier. We hope you will continue to 
turn to us for additional quality products as your computing needs and interests grow. 

How to Use This Guide 
This User’s Guide provides instructions and illustrations on how to install and 

operate your scanner. This guide assumes the user is familiar with Microsoft Windows 
System. If this is not the case, we suggest you learn more about Microsoft Windows by 
referring to your Microsoft Windows manual before using your scanner.  

The Introduction section of this manual describes the box contents and minimum 
computer requirements to use this scanner.  Before you start installing your scanner, 
check the box contents to make sure all parts are included.  If any items are damaged 
or missing, please contact the vendor where you purchased your scanner or our 
customer service directly. 

Chapter I describes how to install scanner’s software and connect the scanner to 
your computer. Note: The scanner connects to your computer through the Universal 
Serial Bus (USB).  If your computer does not support USB technology, you will need to 
purchase a USB interface card to add USB capabilities to your computer, or buy and 
install USB connectors if your motherboard has USB capabilities.  This guide assumes 
that your computer is USB-ready and has a free USB port. 

Chapter II describes how to use, maintain and clean your scanner. 

Appendix A contains the Specifications of the scanner you purchased. 

Appendix B contains our limited warranty agreement and FCC statement 
concerning the product. 
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Conventions of This Guide 
[XXX] — Represents commands or contents on your computer screen. 
Italic   — First use of an important term in a chapter. 
Bold  — Represents buttons on your scanner OR important notes. 

AA  NNoottee  aabboouutt  IIccoonnss  

This guide uses the following icons to point out information that deserves special 
attention. 

 
Warning 

Warning:  A procedure that must be followed carefully to 
prevent injury, or accidents. 

 
Attention 

Attention:  Instructions that are important to remember and 
may prevent mistakes. 

 
Information 

Information:  Optional tips for your reference. 

Safety Precautions 
Before using this device, please read the following important information to 

eliminate or reduce any possibility of causing damage and personal injury. 

1. Usage, the product is for indoor use in dry locations. Moisture condensation may 
occur inside this device and cause malfunction at these conditions: 

• when this device is moved directly from a cold to a warm location; 

• after a cold room is heated; 

• when this device is placed in a damp room. 

To avoid the moisture condensation, you are recommended to follow the procedure: 

i. Seal this device in a plastic bag for it to adapt to room conditions. 

ii. Wait for 1-2 hours before removing this device from the bag. 

2. Do use the USB cable provided with the scanner.  

3. Damaged wire could cause fire or electrical shock. Keep the power cord straight 
and without being twisted, bended, or scraped. 

4. Unplug this device if you don’t need to use for a certain period of time, such as, 
during night or long weekend, to avoid any risks of causing fire. 

5. Do not attempt to disassemble the scanner. There is danger of an electrical shock 



 3

and opening your scanner will void your warranty.   

6. Be sure not to bump or knock the scanner glass as it is fragile and could break. 

Minimum System Requirements1 
 PC with Intel Pentium® II 233 MHz processor or compatible 

 128MB RAM 

 Available USB 2.0 port 

 CD-ROM Drive or DVD-ROM Drive 

 800 MB Free Hard Disk Space 

 Video card that supports 16-bit color or greater 

 Operating System: Windows 2000/XP/Vista/7(compatible) 
 

 

Information 

Systems with Pentium III 500 MHz or higher 
processor (or its compatible), 256 MB RAM, 
available USB 2.0 port and 800MB free hard disk 
space are recommended for optimal performance. 

 

                                                 
1 Higher requirements might be needed when scanning or editing a large quantity of image data.  
The system requirements here are only a guideline, as in general the better the computer 
(motherboard, processor, hard disk, RAM, video graphic card), the better the results. 
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Box Contents2 
 

 

1. Scanner 

2. USB Cable 

3. Quick Guide  

4. Set up/Application CD-ROM 

The Scanner’s Features 

 

1. Scanner Buttons: You may press the button to perform a predefined scanning 
task. 

2. Power LED: It indicates the scanner status. 
 Light Status 

On The scanner is turned on, ready to scan images. 
Off The scanner is off. 

                                                 
2 Save the box and packing materials in case you need to transport this scanner in the future. 
The product packaging can be recycled. 
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3. USB Port: It connects the scanner to a USB port on your computer by the included 
USB cable. 
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Chapter I. Installing the Scanner 
Before installing your scanner, please verify that you have all of the proper 

components. A list of the package contents is provided in the Box Contents section of 
this guide.  

Software Installation Requirements 
Your scanner comes with the OCR software (ABBYY FineReader Sprint), the 

document management software (Presto! PageManager), the image capture software 
(DI Capture), the scanner’s driver and the DocAction software. All of these software 
applications use approximately 800 megabytes of hard disk space after they are 
installed into your computer.  To ensure ample room for the installation, as well as for 
scanning and saving images, a minimum of 1 GB of hard disk space is recommended. 

The USB scanner can only operate under the Microsoft Windows 2000, XP, Vista 
or 7 operating system. 

Hardware Requirements 
This scanner connects to your computer through the Universal Serial Bus (USB), 

which supports hot Plug and Play. To determine whether your computer is USB-
capable, you must check the rear of your PC to locate a USB jack that looks the same 
as the one pictured below. Note that on some computers, the USB port at the rear of 
the computer may be occupied and additional ports may be found on the monitor or 
keyboard. If you are having trouble in locating the USB port on your computer, please 
refer to the hardware manual that came with your computer.  

Upon examination, you should find one or two rectangular USB ports, which usually 
appear as shown below. 

            USB Connector(s) 



 7

If you don’t find such USB ports on your computer, then you need to purchase a 
certified USB interface card to add USB capabilities to your computer. 

Installing and Setting up the Scanner 
Please follow the step-by-step procedures described below to install the Founder 

scanner. 

SStteepp  11..  CCoonnnneeccttiinngg  tthhee  ssccaannnneerr  ttoo  YYoouurr  CCoommppuutteerr  

 
 

 
Attention 

Please make sure the scanner is turned OFF. 

1. Plug the square end of the included USB cable to the USB port at the rear of the 
scanner. 

2. Plug the rectangular end of the USB cable to an available USB port on the back of 
your computer. 

3. If you plan to connect your scanner to a USB hub3, make sure that the hub is 
connected to the USB port in your computer.  Next, connect the scanner to the 
USB hub. 

SStteepp  22..  IInnssttaalllliinngg  tthhee  ssooffttwwaarree  
1. If the USB components on your computer are functioning correctly, they will 

automatically detect the scanner causing the Add New Hardware Wizard or 
Found New Hardware Wizard to be launched. 

 

                                                 
3 The USB hub is not included with the scanner. 
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Information 

If your computer was off when you connected the 
scanner, the Add New Hardware Wizard 
message will be displayed when you turn the 
computer on and when Windows starts. 

2. For Windows 2000: 

a. Click the Next button when the “Add New Hardware Wizard” window is 
displayed. 

b. Select Search for the Best Driver for Your Device [Recommended] and 
click the Next button. 

c. The next window will ask you where to search to find the drive.  Select CD-
ROM drive, and deselect Floppy disk drives if it is checked. 

 

d. Insert the Setup/Application CD-ROM, included with your scanner, into your 
CD-ROM drive and then click the Next button. 

e. Click the Next button in the window that appears. 

f. During the process of the installation, a message “Digital Signature required” 
might be prompted.  Please ignore it, and click the Yes button to continue the 
installation without any misgiving at your scanner functioning. Afterwards, 
please skip to procedure 7. 

3. For Windows XP: 

a. Insert the Setup/Application CD-ROM, included with your scanner, into your 
CD-ROM drive. 

b. Select Install the software automatically recommended and click the Next 
button. 

c. Click the Next button in the window that appears. Afterwards, please skip to 
procedure 7. 

4. For Windows Vista: 

a. Select “Locate and install driver software (recommended)” when the “Found 
New Hardware” window is displayed. 

b. Click on the Continue button when the “User Account Control” dialog pops 
up. 

c. Insert the Setup/Application CD-ROM, included with your scanner, into your 
CD-ROM drive when the system prompts you “Insert the disc that came with 
your USB Scanner“, and click on the Next button. Afterwards, please skip to 
procedure 7. 
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5. For Windows 7: 

When the Setup/Application CD is for several scanner models 

a.  Insert the Setup/Application CD-ROM, included with your scanner, into your 
CD-ROM drive. Click Run install.exe in the AutoPlay window. 

b.  Click on the Yes button if the User Account Control dialog pops up. Follow 
the instructions in the pop-up installation message. 

c.  In the Device Manager window, right-click on this scanner under Other 
devices and select Update Driver Software from the pop-up menu. Click 
Browse my computer for driver software in the window that appears, and 
click the Browse button.  

d.  In the Browse For Folder window, select the folder or the CD-ROM drive 
that contains this scanner’s driver and click the OK button to return to the 
previous screen. Click the Next button and click Install this driver software 
anyway if the Windows Security window appears. Afterwards, please skip 
to procedure 8. 

When the Setup/Application CD is for one scanner model 

a.  Insert the Setup/Application CD-ROM, included with your scanner, into your 
CD-ROM drive. Click Run install.exe in the AutoPlay window. 

b. Click on the Yes button if the User Account Control dialog pops up. If the 
pop-up wizard window appears click Next, and click Install this driver 
software anyway in the Windows Security window then click Finish in the 
wizard window. Afterwards, please skip to procedure 8. 

6. During the process of the installation, a message “Windows can’t verify the 
publisher of this driver software” might be prompted.  Please ignore it, and click on 
Install this driver software anyway to continue the installation without any 
misgiving at your scanner functioning. 

7. When the system completes the installation, click on the Finish button. 

8. Follow the on-screen instructions to install all software that your new USB scanner 
requires. 

9. After the software is installed, close all open applications and click on the Finish 
button to restart your computer. 

10. After the computer is restarted, you will be prompted to perform the scanner 
calibration. 

11. Follow the on-screen instructions to complete the scanner calibration. 
 After the calibration is complete, click OK and then click Finish. 
 

 

Information 

If the scanner installation is not started and 
displayed automatically on the screen, click Start, 
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select Run and type in D:\Install (where D: is the 
drive letter assigned to the CD-ROM drive of your 
computer.)  

SStteepp  33..  TTeessttiinngg  tthhee  SSccaannnneerr  

The following describes how you can check if the scanner is properly functioning 
with your computer and the scanning software by performing your first scan with our 
bundled application NewSoft Presto! PageManager. Before testing your scanner, 
double check to make sure that all connections are securely fastened. 

To properly test your scanner, please perform the following steps:  

1. Open the scanner’s document cover and place a document, head toward the 
scanner button panel, on the scanner glass. 

 

2. Gently close the document cover. 

3. Click the Windows Start button to launch NewSoft Presto! PageManager. 

4. (If you have only one scanner connected with your computer, please skip to 
Step 5.)  
If you have more than one scanner or other imaging device installed on your 
computer:  Click Select Source from the File menu of Presto! PageManager 
and then choose this scanner as the default scanning source. 

5. Within Presto! PageManager, click Tools > Scan Settings > uncheck 
“Suppress TWAIN User Interface” > OK. Click File > Acquire Image Data.  

6. In the TWAIN window that opens, select Flatbed Reflective as the Scan Type. 

7. Click the Scan button. 

8. If an image appears on your screen, your scanner is working properly. 

 

Information 

Please refer to PageManager on-line help for 
further information about using PageManager. 
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Software Setup Troubleshooting 
Carefully review the steps outlined in this guide and the Quick Guide that 

accompanied your scanner.  

If you are still having problems, please check that: 
 You have 800MB of free space on your hard disk drive. 
 The scanner is plugged in and has power. 
 You are using the USB cable supplied with the scanner. 
 The square end of the USB cable is plugged into the rear of the scanner. 
 The rectangular end of the USB cable is plugged into the back of your 

computer. 

If you deviated from the installation procedures defined in this manual, please 
unplug the USB cable from the scanner and reinstall the software from the CD-ROM. 
To reinstall your scanner’s software, click Start, Run, then type D:\Install (where D 
represents the letter of your CD-ROM drive). Carefully follow all the installation 
instructions presented in the Setup Wizard.  Reboot your computer when prompted, 
and plug the USB cable back into the scanner while your computer is still turned on. 

Installing Additional Software 
Your scanner is TWAIN compliant and functions with virtually all available TWAIN 

compatible software. If you purchase additional software to be used with your scanner, 
please make sure that it conforms to the TWAIN standard. 
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Chapter II. Usage and 
Maintenance 

Operating the Scanner 
Your scanner needs to be driven by some type of software program. Since all 

documents or images (whether text or pictures) that are acquired from the scanner are 
treated by your computer as images, most scanning will probably be done from an 
image-editing program where you can view, edit, save and output the scanned images.  
An image-editing program has been bundled with your scanner on the included 
Setup/Application CD-ROM.  It will allow you to alter and correct any scanned images 
by using a variety of filters, tools and effects.  

What about scanning text documents and editing them in a word processor? This is 
the role of Optical Character Recognition (OCR) software. OCR software converts the 
image files that are created from scanning text documents into text files that can be 
viewed, edited and saved by word processors.  An OCR program has also been 
bundled on the included Setup/Application CD-ROM, and if you wish to use the 
scanner in this way you should install the OCR software that is included. 

DI Capture, as its name suggests, is a specialized document image capture 
program that allows you to conveniently digitize your paper documents and 
automatically save their electronic files in the designated folder.  If you are not familiar 
with scanning, no problem:  the Scan Wizard will guide you through to complete each 
scanning task. 

The DocAction program, seamlessly integrating the operation of your scanner with 
your computer and other peripherals, provides a quick and convenient way to perform 
various scanning functions.  With DocAction, you don't need to adjust settings every 
time you scan. Simply press any button on the scanner's front panel or click any 
scanning menu item of DocAction on the screen. The scanner starts to scan your paper 
documents and transfer them to your assigned destination. The destination can be a 
printer, your e-mail program, files on your disk drives, an image-editing program, etc. 

Please refer to the online help of each program to guide you through any question 
you may have while scanning within that program. 

Preparation 
1. Open the document cover and place your document on the scanner glass. Align 

the document with the  mark on the scanner.  
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2. Gently close the document cover. 

Scan the Image(s) 
There are four different ways to operate the scanner: 

1. By acquiring images from the scanner through our TWAIN interface within 
any TWAIN-compliant application programs. 

2. By scanning from the scan button on the scanner. 

3. By scanning images within DocAction software. 

4. By scanning images within our DI Capture software. 

The TWAIN interface, DI Capture and DocAction software are automatically 
installed to your system along with the scanner driver. 

 

Attention 

Before you start scanning, check the following: 

 The power of both your computer and 
scanner is turned on. 

 The icon  appears on the Windows 
system tray. 

 The paper is appropriately placed on the 
scanner flatbed glass. 

SSccaannnniinngg  vviiaa  TTWWAAIINN  IInntteerrffaaccee  

The TWAIN program is a very important piece of software that comes with your 
scanner.  This program acts as an interface between the scanner hardware and the 
image-editing software you are using to view and edit images. The TWAIN program 
allows you to adjust a number of settings to define the quality of the scanned image. 

The following describes how you may use our bundled application NewSoft Presto! 
PageManager to scan via the TWAIN interface.  When you get familiar with the 
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scanning, you may alternatively use other TWAIN compatible scanning programs or 
image-editing applications to do your scanning projects. 

 

Scan within NewSoft Presto! PageManager: 
1. Click the Windows Start button to launch Presto! PageManager. 

 

Attention 

If you have more than one scanner or other 
imaging devices installed on your computer, you 
need to set this scanner as the default scanning 
source before you acquire the TWAIN program. 

1. From the File menu of Presto! PageManager, 
click Select Source. 

2. In the window that opens, choose this 
scanner and then click the OK button to set 
this scanner as the default scanning source. 

2. Within Presto! PageManager, click Tools > Scan Settings > uncheck 
“Suppress TWAIN User Interface” > OK. Click File > Acquire Image Data.  

3. In the TWAIN window that opens, select Flatbed Reflective as the Scan Type. 

 
4. Adjust the scanning settings. 
5. Click the Preview button.  The scanned image should appear in the Preview 

Window.  To define the margins and crop out sections of the image you don’t 
want scanned, use the mouse to click and drag the corners or sides of the scan 
area borders.  Adjust the scan settings again if the preview image doesn’t 
satisfy your needs. 

6. Click the Scan button. 
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7. When the scan finishes, click the Exit button to close the TWAIN window.  The 
scanned images are displayed in Presto! PageManager, and you may perform 
the image editing tasks. 

 Click the Help button within the TWAIN window for more information about the 
settings. 

SSccaannnniinngg  ffrroomm  tthhee  SSccaannnneerr’’ss  PPaanneell  oorr  OOnn--ssccrreeeenn  DDooccAAccttiioonn''ss  
EExxeeccuuttee  MMeennuu    

The settings for each button on the scanner's panel are configured through 
DocAction.  DocAction offers you quick access to the most frequently-used scanning 
functions.  They are especially useful when you need to repeatedly scan with the same 
settings and send images to the same destination. 

Buttons on the scanner panel will be used in this guide to demonstrate the scanner 
operations. You may also use DocAction's on-screen Execute menu to perform the 
same scanning tasks.   

 

Configure Button Settings 

Before performing your first scan via scanner buttons, you are recommended to 
configure the button settings to your needs and preferences first.  There are two ways 
to configure or view the button settings of DocAction: 

 Double-click the icon  in the Windows system tray. 

 Right-click the icon  in the Windows system tray, and then choose 
Button Configuration in the pop-up menu that opens. 

Within the “Button Configuration” window, you can find a row of icons running 
through the left side of the window. Each icon corresponds to a button on your 
scanner's panel (as well as DocAction's on-screen Execute menu).  Clicking any icon 
on the left pane and its current button settings are displayed immediately on the right 
pane. You may adjust the settings as desired. 

Click the Help button within the Button Configuration window for more information 
about the settings. 

 

Scan from the Buttons 

Scanning documents or images from this scanner is very easy. Follow the two 
steps described below: 

1. Place the document or images onto the scanner. (Refer to ”Preparation” of this 
guide for more information in placing paper on the flatbed glass properly.) 
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Attention 

Place only text documents for OCR purposes. 
Do not scan a photo using the OCR button. 

2. Do one of the following to start scanning: 
 Press the button from the scanner's panel. 

 Right-click the icon  in the Windows system tray, and then choose 
Execute in the pop-up menu that opens. Click the desired button function 
item in the pop-up menu. 

The scanner starts to scan immediately and carry out the corresponding action 
according to the settings you have set up in the Button Configuration window. 

SSccaannnniinngg  ffrroomm  DDII  CCaappttuurree  PPrrooggrraamm  
1. Click the Windows Start button to launch DI Capture. 

 

 

 

 
2. Within DI Capture, select this scanner from the drop-down list of 

. 
3. Select a document from the Folder Pane to store the scanned images. 

(To create a new folder and/or a new document, click the New Folder and/or 
New Document button from the toolbar. 

4. Select an appropriate scan profile.  (You may click the tab of Scan Settings 
Pane to check if the current settings of the selected scan profile meet your 
needs.  If not, you may click the Create or Manage button beside the Scan 
Profile to create a new profile or modify an existing profile.) 

5. Click the Scan – Append button from the toolbar. 

Folder 
Pane 

Select the 
scanner 

Scan Profile

Viewer 
Pane 

Browser 
Pane 

Toolbar 

Scan Settings Pane 
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6. When the scan finishes, all scanned images are displayed on the Browser 
Pane.  The last scanned image appears on the Viewer Pane. 

Alternatively you may click the Scan Wizard button from the toolbar to let the Scan 
Wizard guide you through the entire scan process. 

You may also tailor your own user interface of DI Capture such as the toolbar 
buttons, Viewer Pane, Browser Pane, etc. 

Refer to the online help of DI Capture to explorer more about DI Capture! 

Scanner Connection 
The first step to take when troubleshooting connection problems with your scanner 

is to check all physical connections.  The icon , located on the Windows system 
tray, indicates if the scanner software is properly launched and the scanner and 
computer are communicating with each other. 

Appearance Status 

 
The program has been successfully launched and the scanner 
is connected with the computer, ready to scan images.  

 
The scanner is not connected with the computer.  

No Display You have chosen to terminate the program, no matter the 
scanner is connected or disconnected with the computer. 

Calibrating the Scanner 
Calibrate the scanner if colors appear in areas that should be white, or colors of the 

scanned image and the original vary a lot. This allows you to adjust and compensate 
for variations that can occur in the optical component over time by its nature.  

The following describes how to calibrate the scanner: 

1. Click Start > All Programs > Your scanner model name > Calibration 
Wizard. 

2. Click Next from the Calibration Wizard that pops up. 

3. Click Calibrate Now....  

4. After the calibration is complete, click OK and then click Finish. 

Usage & Maintenance Tips 
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Attention  

To keep your scanner working smoothly, take a 
moment to review the following usage & 
maintenance tips. 

 Avoid using the scanner in a dusty environment.  Dust particles and other 
foreign objects may damage the unit. 

 Do not subject the scanner to excessive vibration. It may damage the internal 
components. 

 Clean the scanner glass by lightly spraying a non-abrasive glass cleaner onto 
a soft lint-free cloth. Then, wipe the glass thoroughly with the cloth. DO NOT 
SPRAY CLEANER DIRECTLY ONTO THE SCANNER GLASS. Excess liquid 
residue may fog or damage the scanner. 

 Your scanner operates best in temperatures between 10° C and 40° C (50° F 
to 104° F). 
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Appendix A: Specifications4 
 

Founder T2800 
Physical 
Dimensions 378 x 257 x 33 mm (14.88” x 10.12” x 1.30”) 

Weight 1.4 Kgs (3.1 Lbs) 
Operating 
Temperature 5° C to 40° C 

Max. Scan Area A4/Letter: 216 mm x 297 mm (8.5 x 11.69 in.) 
Scan Method Single-Pass 

Scan Modes Color: Input 48-bit; Output 24-bit 
Grayscale: Input 16-bit; Output 8-bit 

Resolution Optical Resolution: 1200 dpi 
Max. Interpolated Resolution: 24000 dpi  

Scanning 
Materials Reflective color or black-and-white originals 

Protocols TWAIN Compliant  
Connection USB Port  
Light Source Three-colour RGB LEDs 
Power 
Requirements 

Powered through USB port 
No AC adapter required 

Power 
Consumption 

Operation: 2.5 watts maximum 
Idle: 1.25 watts  

EMI FCC Class B 
 

                                                 
4 Hardware specifications may change at any time without prior notice. 
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Appendix B: 
Customer Service and Warranty 

If you encounter problems with your scanner, please review the installation 
instructions and troubleshooting suggestions contained in this guide. 

For further assistance call our customer support phone number listed on the last 
page of this guide. One of our representatives will be happy to assist you from Monday 
through Friday in office working hours as shown below: 

Europe 9:00 a.m. – 5:30 p.m.  (CET) 
Other Countries or Areas 9:00 a.m. – 6:00 p.m. Taiwan Time 

To avoid delays, please have the following information available before calling: 
 Scanner name and model number 
 Scanner serial number (Located at the bottom of the scanner) 
 A detailed description of the problem 
 Your computer manufacturer and its model number 
 The speed of your CPU (Pentium 233, etc.) 
 Your current operating system and BIOS (optional) 
 Name of software package(s), version or release number and manufacturer 

of the software 
 Other USB devices installed 

Service & Support Information (For EU country 
only) 

Where appropriate, the period of availability of spare parts and the possibilities of 
upgrading products information. Please ask local distributors and suppliers for spare 
parts information and product upgrade information. 

Information requested by relevant Implementing Measure. Please ask local 
distributors and suppliers for the related information of Implementing Measure test 
report. 

Do not dispose anything of products before you ask local distributors and suppliers 
to get correct information for decreases of environmental impact with right methods and 
procedures. 

If you want to disposals the product and/or an accessory, please ask local 
distributors and suppliers to get the contact information of nearest disposal 
manufactures. 

If you have any maintenance inquiry, please ask local distributors and suppliers to 
get the contact information of nearest maintenance center in order to extend the 
product usage life time. 
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If you want to maintain and clearance the product, please ask local distributors and 
suppliers to get the right information of nearest stores. 

Statement of Limited Warranty 
This Statement of Limited Warranty applies only to the options you originally 

purchase for your use, and not for resale, from an authorized reseller. 

The manufacturer warranty includes all parts and labor, and is not valid without the 
receipt of original purchase. To obtain warranty service, you may contact the 
authorized dealer or distributor, or visit our website to check out the available service 
information, or send a request via E-mail for further help. 

If you transfer this product to another user, warranty service is available to that user 
for the remainder of the warranty period. You should give your proof of purchase and 
this statement to that user. 

We warrant that this machine will be in good working order and will conform to its 
functional descriptions in the documentation provided. Upon provision of proof of 
purchase, replacement parts assume the remaining warranty of the parts they replace. 

Before presenting this product for warranty service, you must remove all programs, 
data and removable storage media. Products returned without guides and software will 
be replaced without guides and software. 

This Limited Warranty service does not provide for carry-in exchange when the 
problem results from accident, disaster, vandalism, misuse, abuse, unsuitable 
environment, program modification, another machine or non-vendor modification for 
this product. 

If this product is an optional feature, this Limited Warranty applies only when the 
feature is used in a machine for which it was designed. 

If you have any questions about your Limited Warranty, contact the approved 
retailer from whom you bought the product or the manufacturer. 

THIS LIMITED WARRANTY REPLACES ALL OTHER WARRANTIES, EXPRESS 
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABLITY AND FITNESS FOR A PARTICULAR PURPOSE. HOWEVER, 
SOME LAWS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES. IF 
THESE LAWS APPLY, THEN ALL EXPRESS AND IMPLIED WARRANTIES ARE 
LIMITED IN DURATION TO THE WARRANTY PERIOD. NO OTHER WARRANTIES 
APPLY AFTER THAT PERIOD. 

Some jurisdictions do not allow limitations on how long an implied warranty lasts, 
so the above limitation may not apply. 

Under no circumstances are we liable for any of the following: 

1. Third party claims against you for losses or damages. 
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2. Loss of, or damage to, your records or data; or 

3. Economic consequential damages (including lost profits or savings) or 
incidental damages, even if we are informed of their possibility. 

Some jurisdictions do not allow the exclusion or limitations of incidental or 
consequential damages, so the above limitation or exclusion may not apply to you. 

This Limited Warranty gives you specific legal rights, and you may also have other 
rights that vary from jurisdiction to jurisdiction. 

FCC Radio Frequency Statement 
This equipment has been tested and found to comply with the limits for a Class B 

digital device, pursuant to part 15 of the FCC rules. These limits are designed to 
provide reasonable protection against harmful interference in a residential installation.  

This equipment generates, uses and can radiate radio frequency energy and, if not 
installed and used in accordance with the instructions, may cause harmful interference 
to radio communications. However, there is no guarantee that interference will not 
occur in a particular television reception (which can be determined by turning the 
equipment off and on), the user is encouraged to try to correct the interference by one 
or more of the following measures: 

 Reorient or relocate the receiving antenna. 
 Increase the separation between the equipment and receiver. 
 Connect the equipment to an outlet on a circuit different from that which the 

receiver is connected. 
 Shielded interconnect cables and shielded power cord which are supplied 

with this equipment must be employed with this equipment to ensure 
compliance with the pertinent RF emission limits governing this device. 

 Consult the dealer or an experienced radio/TV technician for help if the 
conditions persist. 

 Changes or modifications not expressly approved by the manufacturer or 
authorized service center could void the user’s authority to operate this 
equipment. 

 
This device complies with Part 15 of the FCC Rules.  Operation is subject to the 

following two conditions: (1) this device may not cause harmful interference, and (2) 
this device must accept any interference received, including interference that may 
cause undesired operation. 
 


